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Use of Equipment 
 
The Equipment was manufactured under patents licensed to Z Corp. to be used for the fabrication of 
appearance models and prototypes.  Other uses may be restricted; contact Z Corporation for further 
information. 
 
The Equipment is designed to be used by design engineers and other professionals in the production 
of early-stage 3D appearance models and prototypes.  The Equipment is not to be used to produce, 
either directly or indirectly, medical or other products that may require precise dimensions or 
tolerances to ensure the safe and effective operation of such products.  You agree to indemnify, 
defend and hold Z Corporation and its officers, directors and employees harmless from and against 
any and all claims, losses, damages, costs and expenses resulting from any use of the Equipment 
other than for the production of early-stage appearance models and prototypes.  
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1. YOUR Z400 SYSTEM 

1.1. INTRODUCTION 

1.1.1. OVERVIEW 

This Z400 System User Manual will speed you along the path towards quickly and 
inexpensively building parts.  We recommend that you use this manual together with our 
training video for best results.  The manual contains the following sections: 

1. Introduction.  This section will give you an overview of the principles behind the Z400  
System 3D Printer, familiarize you with the terminology we will use to describe the Z400 
System and introduce you to some of the features of this manual.  This section concludes 
with an outline of the three quick and easy steps to printing parts. 

2. Setting up the Build.  The ZPrint Software (also referred to as “Software”) allows you to 
take your 3D CAD file and change it so that you can print the size of parts and 
assortment of parts that you need. 

3. Preparing the Z400 System to Print.  This section will guide you through putting 
powder and binder solution in the Z400  Printer, and preparing the system to print a part. 

4. Printing a Part.  Here we describe a few steps of actually printing the part. 

5. Post Processing of Parts.  This section leads you through removing the printed parts, 
removing any excess powder and infiltrating the parts with resin to improve strength and 
finish. 

6. Advanced User Features.  This section will help you get the maximum performance out 
of your Z400 System. 

7. Maintenance.  Here we review a few preventative maintenance steps, offer some tips for 
troubleshooting and tell you where to go if you experience any problems with the system. 

8. Appendix.  Here you will find a few useful forms and references. 

9. Index. 
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1.1.2. HOW IT WORKS  

The Z400  System is based on the Massachusetts Institute of Technology’s patented 3DP™ (Three-
Dimensional Printing) technology. 

The Software first converts a three-dimensional design built using 3D CAD (and saved in STL format) 
into thousands of cross-sections or slices that can be between 0.003” – 0.009” thick.   

The Z400 Printer then prints these cross-sections one after another from the bottom of the design to 
the top. 

Inside the Z400 3D Printer there are two pistons (see Figure 1.)  The feed piston is represented in the 
diagrams below on the left and is shown in the ‘down’ position filled with powder.  The build piston is 
the piston on the right, shown below in the ‘up’ position.  Also represented in the diagrams is the roller 
(drawn as a circle) and the print assembly (drawn as a square.)  On the Z400  Printer, the roller and 
the print assembly are mounted together on the gantry which moves horizontally across the build 
area. 

To begin the 3D printing process, the Z400  System first spreads a layer of zp series powder in the 
same thickness as the cross section to be printed.  Using 128 jets, the Z400 binder cartridge then 
applies a binder solution to the powder, causing the powder particles to bind to one another and to 
the printed cross-section one level below.  The feed piston comes up one layer of thickness and the 
build piston drops one layer of the thickness.  The Z400 System then spreads a new layer of powder 
and repeats the process, and in a short time the entire part is printed. 

   

Step 1: As the gantry traverses left 
to right, the roller collects powder. 

Step 2: The roller spreads a thin 
layer of powder over the build 
piston. 

Step 3: The roller discharges 
excess powder down the powder 
overflow chute. 

 

  

 

 Step 4: As the gantry traverses 
right to left, the print assembly 
prints the part cross-section. 

Step 5: The feed piston moves up 
one layer, the build piston moves 
down one layer, and the process is 
repeated. 

 

Figure 1. The Printing Process 
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The Z400 System employs several techniques to quickly build great parts. First, binder solution is 
applied in a higher concentration around the edges of the part, creating a strong “shell” around the 
exterior of the part.  Within parts, the Z400 Printer builds an infrastructure by printing strong 
scaffolding within part walls with a higher concentration of binder solution.  The remaining interior 
areas are printed with a lower saturation, which gives them stability, but prevents over saturation, 

which can lead to part distortion. 

 

Figure 2: Representation of the Z400 Shelling and Infrastructure Features  

After printing, the part is removed from the powder bed, depowdered and dried.  The part can then be 
infiltrated with wax, epoxy, or other materials to increase strength and durability.  You will have the 
part in your hands and can start improving your design within the same day—usually within hours. 

Because the powder layers support the structures being printed above, the Z400 System prints parts 
without support structures of any kind and can print parts with complex geometries that are 
impossible for other systems. 

There are several important characteristics of the Z400 System that will help you print the best parts 
for your intended purpose. 

Part Placement.  The Software will automatically place the parts within the build box to maximize 
build speed, the most important criteria for the majority of our users.  The Software positions the parts 
with the smallest dimension in the z (vertical) axis.  In addition to part placement, however, the 
following other characteristics should be considered. 

Strength.  The ultimate strength of the part will be affected by its orientation within the print box.  The 
part will be strongest along the y-axis and the x-axis and less strong along the z-axis.  This is 
because the cross sections are printed in continuous strips along the y-axis (the binder cartridge 
direction of travel), bands across the x-axis (the gantry direction of travel) and laminated layers along 
the z-axis.  (See figure 3 below.)  This discussion only applies to untreated parts; once parts are 
infiltrated, they uniformly take on the strength characteristics of the infiltrating material. 

Exterior walls printed at 
higher saturation. 

Interior infrastructure 
printed at a higher saturation 

Other interior areas 
printed at lower 
saturation 
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Figure 3:  Illustration of Z400 System Print Orientations  

Accuracy.  The accuracy of the system depends on the materials you choose.  Our basic material, 
starch-based powder , is accurate to within + 0.005 inches in the x-y plane and to within 0.010 inches 
along the z-axis per inch.  These figures represent repeatability, rather than expected shrinkage.  You 
can employ the anisotropic scaling feature in the Software to adjust for expected shrinkage and bring 
your parts into true scale.  See Section 5, Printing the Part, instruction number 4 for more on the 
anisotropic scaling feature.  

Accuracy will be greatly enhanced if you process your parts in a consistent way.  Outlined later in this 
manual are some broad guidelines for part handling which will help you get the most out of your Z400 
System. 

The Z400 System is calibrated to be most accurate in a normal office or industrial environment.  
Because differences in humidity and other factors can have an effect on shrinkage, if you notice 
shrinkage in parts, we recommend that you recalibrate your machine, as outlined in Section 7.4, 
Calibration for Anisotropic Scaling.  This process will lead you through a series of steps that will 
produce new scaling factors, which you can then enter into the Software.   

 

Strong  

z-axis 

x-axis  

y-axis 

Strong 

Less Strong 
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1.1.3. THE PARTS OF THE Z400  THREE DIMENSIONAL PRINTER 

 

Figure 4: The Z400  System Three Dimensional Printer 

Overflow Chute 

Build Box 

Printer 
A bl

Feed Box 
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1.1.4. SYSTEM COMPONENTS 

 

  

 

 

 

 

 

 

 

Figure 5: Z400  System Components 

 

 

ZD4i Depowdering Station Z400 3D Printer 
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1.2. PRINTING A PART 1-2-3 

Printing a part using the Z400  Printer is fast, easy, clean and fully compatible with an office 
environment.  This manual will show tips on how to print the most challenging parts, but for most 
purposes printing a part is as simple as 1-2-3. 

1.2.1. STEP 1: IMPORTING THE PART  

Once you open the Software, you will be presented with the ‘Open’ dialog box.  Select the 3D CAD 
file you wish to print.  Conversion of the file from 3D CAD format usually takes a few seconds and can 
take up to several minutes for the largest files.  The Software allows you to move, rescale and modify 
your part in several ways before printing. 

1.2.2. STEP 2: PREPARING THE THREE DIMENSIONAL PRINTER  

Carefully following the steps outlined in Chapter 4, an experienced operator can prepare the three 
dimensional printer in less than five minutes.  The operator will put powder in the feed box, and 
ensure that there is enough binder solution and that the  overflow bin is empty. 

1.2.3. STEP 3: PRINTING THE PART  

The Z400 System prints most parts in minutes and prints even the largest parts in a few hours.  The 
operator then removes the part, removes any excess powder and, if desired, dries and infiltrates the 
part with wax or other materials to give the part the desired strength and finish.  Post-processing 
phase takes less than ten minutes for simple parts and only an hour or so for the most massive parts. 

Once you have completed these steps you are ready to start using parts to improve design, 
communicate with other departments and reduce the time it takes you to get new products to market. 
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2. SETTING UP THE BUILD 

This chapter will briefly explain how to set up the build, check the 3D Print Settings, and 
print. For more information about the features in the Software, please refer to the ZPrint 
Software Manual. 

 

PLEASE NOTE: If the ZPrint Software has not been installed, install the Software. Instructions are 
located in Section 1.1 of the ZPrint Software Manual. 

 

2.1. OPEN OR IMPORT THE 
FILE 

 

1. Open the Software. The open dialog box 
will appear.  

2. Choose the file you wish to open. 

3. Click ‘Open’ or double-click the file. 

4. Choose the dimensions and powder type 
you will be using. 

5. Click ‘OK’. 

6. The file will be brought into the Software 
and sliced. 

If you would like to open additional files, 
choose the ‘Import’ option under the File menu. 
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2.2. ORIENTING THE PART 

2.2.1. PART CONTAINING AN 
OPENING OR HOLLOW 
AREA 

• If the part has an opening or is 
hollow, place the opening or hollow 
side up. This will allow for the 
removal of powder during the gross 
depowdering process. 

 

Part with
Opening

Hollow Part

 

2.2.2. PART CONTAINING 
OVERHANGS 

 
• Unsupported overhangs should be 

placed on the left hand-side and as 
close to the build plate as possible. 
The plaster powder, being 
extremely fine, is more fluid in the 
build. Placing a small solid piece 
underneath overhanging surfaces 
would reduce the movement of the 
overhang.  

 

• Cylindrical features will be more 
accurate when their axis is parallel 
to the z-axis. For example, if you 
were to print a bottle, the bottle 
would best be printed standing up, 
with the mouth of the bottle facing 
the top of the Printer. 

 

 

1.4

2.0
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2.3. CHECKING BUILD SETTINGS 

ALWAYS check build settings before 
printing: 

1. Choose the ‘3D Print Setup’ option 
from the File menu (or toolbar).  

2. Check that the selected printer, 
powder type, and powder settings 
for the build are correct.  The 
Software settings are the 
recommended values.  

3. If the settings need to be changed, 
select ‘Override’. Press ‘OK’ to 
confirm.   

 

For more information on how to 
change the settings, please refer to the 
ZPrint Software Manual.  

• It is also strongly recommended 
that slice viewing and collision 
detection (if more than one part is 
being printed) be used before 
beginning the build. These features 
are found under the View menu of 
the Software.  

• Slice Viewing allows you to view 
the cross sections of the part to 
identify any slice errors.  

• Collision detection will scan 
through the slices and report the 
layer in which part overlapping is 
found. 
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2.3.1. POWDER SETTINGS 

2.3.1.1. Anisotropic Scaling Values 
 
Anisotropic scaling values scale the model to accommodate any shrinkage or expansion of the part 
either due to characteristics of the material system or infiltrant system. A scaling value of one (1) is 
equal to 100% of the part in a specific axis. If the part shrinks 1% in a certain axis, the correct 
anisotropic scaling value would be 1.01 in that axis. The Software will display the recommended 
values for each powder type. The scaling factors may differ according to wall thickness and 
geometry of the part.  A higher accuracy level may be obtained by measuring the part and adjusting 
anisotropic scaling values as needed. To obtain new anisotropic scaling factors that are part 
specific, print the part with scaling factors of one (1) in all axes. Once the part is completed, post-
process the part. Measure the x-, y-, and z-axes. Divide the nominal value by the measured value. 
For example, if the printed part had a nominal value of 1 and had a measured value of 0.98, the 
scaling value would be 1.02. After calculating the anisotropic scaling values, input them into the 
Software and reprint the part and follow the post-processing procedure.   

1. Plaster Material System 

The plaster material system has been found to remain dimensionally accurate during printing and 
thus, the recommended anisotropic scaling values are one (1) in all axes. If the infiltrant system 
being used changes the accuracy of the part, please alter the values as needed.  

2. Starch Material System  

The shrinkage found in the starch material system is proportional to the part geometry and the 
drying time of the part. The longer the part is left to dry, the larger the shrinkage value. The part is 
most stable in the x and y-axis and shrinks more in the z-axis. Thus, the anisotropic scaling factor of 
the z-axis will always be greater than the values for both the x- and y-axes.  
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2.3.1.2. Saturation Values 
The saturation values determine how much binder is placed on the powder to print the part. The part 
is made up of two areas, the shell and the core, as described in Section 1.1.2, How It Works. Thus, 
there are two saturation values, one for the shell and core. In general, the shell saturation is higher 
than the core saturation. The ZPrint Software will display the recommended values for each powder 
type. 

 

1. Plaster Material System 

The shell and core saturation values for the plaster material system are generally constant values, 
meaning that there is only one value for all geometry types.  

2. Starch Material System  

The shell and core saturation values for the starch material system depend on part geometry. A 
thick walled part will have lower shell saturation than a thin walled part. Core saturation is 
dependent on the wall thickness of the part. The thinner the wall thickness the higher the core 
saturation; the thicker the wall thickness the lower the core saturation.  

The Software will recommend shell and core saturation values based on the part geometry.  If parts 
come out weak, increase the saturation values by 10%; if parts are difficult to depowder, decrease 
the saturation values by 10%. 

2.4. PRINTING THE BUILD 

 
It is strongly recommended that the build 
settings be confirmed before printing. To 
check build settings, choose ‘3D Print Setup’ 
under the File menu or click on the icon 
located on the taskbar.  
 
After all build settings have been confirmed:  

 

1. Choose ‘3D Print’ under the File menu.   

2. A dialog box will appear asking that 
powder and fluid levels be checked.  

3. Press ‘OK’ to confirm that these have 
been checked to begin the build.  

Once the build has begun, a dialog box will 
appear reporting the status of the build. 
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3. PREPARING THE Z400  SYSTEM TO PRINT 

3.1. HARDWARE CONTROLS 

The front control panel on the Z400 3D Printer has the following features: 

 

 

 

 

 

 

 

 

 

 

Note: When the system is online, all buttons except the Online Button are disabled. 

 

Online Indicator Light 

FeedUp/Feed Down 
Buttons. Allows user to raise 
or lower the piston in the 
Feed Box. A light tap raises 
(or lowers) one layer of 
thickness; holding down 
causes continuous motion. 

Build Up/Down Buttons. 
Allows user to raise or 
lower the piston in the 
Build Box. A light tap 
raises (or lowers) one 
layer of thickness; holding 
down causes continuous 
motion

Online Button. 
Enables and 
disables printer 
communication. 

Spread Button. If gantry is on the left side of the deck, 
a brief push of this button causes the gantry to spread 
a layer of powder. If the gantry is on the right end of the 
deck, a brief push of the button will cause the gantry to 
move to the left side of the deck. Holding down this 
button will result in continuous spreading of powder. 



Z400 User Manual Z Corporation 

3-2 

3.2. PREPARING THE THREE DIMENSIONAL PRINTER 

Z Corporation offers a variety of powder-binder systems for use with the Z400 3D Printer.  
Each system provides specific advantages to the customer, and can be used interchangeably 
on the Z400 System.  Depending on which material system you choose, there will be slight 
differences when setting up your machine. Please refer to the Powder Fact Sheet for more 
information about printer settings for each material system.  

 

Printer/Materials 
zp®14 

powder 
zp15e 

powder 
zp100 

powder 
zbTM4 
binder 

zb7 
binder 

Binder Cartidge 
(05470) 

Z400 Printer Y Y Y 
w/zp14 or 

zp15e 
With all 
powders Y 
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3.2.1. SETTING UP THE PRINTER FOR A PART 

If the machine is off, switch it on by pressing the Power ON/OFF Switch and releasing.  The Red 
Power Light and yellow error light will turn on.  After approximately 15 seconds, the Vacuum Blower 
will come on, and the error light will go off.  Then Gantry will move slowly as it zeroes itself.  We 
recommend that you leave the machine on at all times—a warm machine prints better parts. 

 

Figure 6: Gantry Detail View (Top View) 
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Build Box 

Gantry top cover (with cut-

Gutter 
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1. Wait for the green Online light to light up indicating that the power-up procedure has 
completed.  The warm up process should take between 60 and 90 seconds. 

2. Take machine off line by pressing the Online Button and releasing. 

3. Open the clear Top Cover to gain access to the build area. 

TIPS AND TRICKS… 

LEAVE THE MACHINE ON!  The Z400 Printer prints 
better parts when the machine has warmed up. 

 

 

 

3.2.2. FILLING FEED BOX WITH POWDER 

 

1. Press and hold the Feed Down button until the piston 
reaches the bottom of the Feed Box.  The piston will stop 
when it reaches the bottom.  

2. Open a bag of fresh powder1 and carefully place the bag 
upside down in Feed Box with the edges of the open end of 
the bag touching or slightly below the powder level. 

3. Carefully withdraw the bag from the Feed Box, allowing the 
powder to flow out.  Twisting the bag slowly as it is helps 
powder to emerge smoothly. 

 

4. Grip the Powder Scoop and insert it repeatedly a few inches into the loose powder to compact it.  
Continue for about a minute until it feels firm. 

5. For each powder bag added to the Feed Box, repeat steps 2, 3 and 4. 

6. When Feed Box is filled to top, take the Tamper and slowly press it onto the powder surface. Be 
careful not to “slap” the Tamper into the Feed Box, which will produce airborne particles. About 
10-15 pounds of force will give a smooth, flat, and compact surface.  Failure to firmly pack Feed 
Box will affect part fidelity. 

                                                      
1 Powder should be stored at room temperature (between 65 to 75 degrees Fahrenheit), dry, ventilated area 
away from sources of heat and moisture.  Keep containers tightly closed.  Avoid handling procedures which 
produce dust.  Powder is combustible.  Gloves are recommended for direct contact. 
3 Store binder in a cool, dry place away from the sun.  Keep tightly capped.  Keep away from heat.  Gloves and 
safety glasses are recommended for direct contact. 
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7. Vacuum up any powder spilled on the Top Deck.  

8.  Press and hold the Feed Up Button until the surface of 
the powder is even with the Top Deck. 

TIPS AND TRICKS… 

Keep powder containers closed when not in use to keep 
powder dry. 

Scoop powder carefully to minimize airborne powder.  

Make sure that you carefully vacuum up excess powder.  It 
only takes a minute, and the tidier the machine is, the less 
often it will need maintenance! 

 

 

 

 

 

Warning: Use only powder supplied by Z Corporation.  Use of any other material may impact the 
performance and/or safety of your Z400  System. 

3.2.3. PREPARING THE BUILD BOX 

1. Make sure the Build Box is clean and the Build Piston is about a quarter of an  
inch below the Top Deck.  

2. Press and hold the Spread Button until a uniform bed of powder is formed in the 
Build Box.  The gantry will traverse the top deck 8-10 times before a uniform bed 
of powder is in place. 
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3.2.4. RINSING THE CARWASH 

The Carwash cleans the nozzle array of the Binder Cartridge during printing.  Always rinse 
out the Carwash before and after each build.   

Figure 9:  Carwash Detail  

To clean the Carwash:  

1. Take the machine Off Line. 

2. Manually pull the Binder Cartridge forward out of its parked position.  

3. Rinse the Carwash, especially the Squeegee and the Suction Cup, with either 
distilled water or binder.  This should dissolve off any dried deposits of powder.   
Never dry out the carwash area. 

4. If there is any powder inside the gantry along the path of the Binder Cartridge, 
vacuum or wipe it up.  The tidier the machine is, the less often it will need 
maintenance. 

5. Push the Binder Cartridge back to the parked position.    

6. Close the clear Top Cover. 

PLEASE NOTE: If your machine is not used every day, squirt water into the suction 
cup after use and park the Binder Cartridge in the Car Wash.  This will prevent the 
jets from drying out between builds. 

 

 

 

 

Mounting Screws 
(Do Not Adjust!) 

Suction Cup 

Squeegee 
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3.2.5. CHECKING FLUID LEVELS  

1. Open the doors at the bottom front of the machine. 

2. Check the jugs on the left side.  If the binder waste bottle on the extreme left is 
three-fourths full, empty it out.  Binder waste should be treated in accordance 
with local regulations.  If the binder supply jug is approaching the bottom rim of 
the bottle, replace it by unscrewing the top from the empty bottle and refastening 
the top to a full binder solution bottle.3 

3. Close the doors on the front of the machine.  Do not run the machine with the doors 
open. 

Warning: Do not recycle waste binder solution.  The binder waste is contaminated with powder and 
use of this waste in the Z400 System will clog the internal plumbing system and the binder cartridge.  
Use only binder supplied by Z Corporation.  Use of any other material may impact the performance 
and / or safety of your Z400 System. 

3.2.6. CHECKING POWDER OVERFLOW BAG  

Check the Powder Overflow Bin at the right side of the 
machine.   

1. Remove the Powder Overflow Bin. 

 

2. After emptying the overflow bin, vacuum the filter 
located on top of the overflow bin. Then slide the bin all 
the way back. 

 

 

 

  

3.2.7. PUTTING THE MACHINE ONLINE 

Note:  The excess powder in the build box and the 
overflow bin has absorbed moisture and has a changed 
fiber consistency that will not reliably print good parts.  
Powder may be recycled when mixed with 30% -50% 
fresh powder. 
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Press the Online button.  The green Online Indicator Light will illuminate.  The Z400 3D Printer is now 
ready to print. 

TIPS AND TRICKS… 

Keep the Machine Clean! 

Make sure that you have enough powder to complete the build.  It is 
wise to always begin a build with a full feed box. 

CHECK THE OVERFLOW BIN! If the overflow bin becomes full, 
powder will back up through the system and create a messy problem.  
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4. PRINTING THE PART 

 

 

Choose 3D Print Setup from the File menu.  In the print 
setup dialog box the Software allows you to choose 
three print parameters.  

1. Select Layer Thickness.  The Z400  printer can 
print parts with layer thickness ranging from 
0.0035-0.009”.  Please refer to the Powder Fact 
Sheet for recommended layer thickness settings. 

2. Select Saturation Level.  The Software will direct 
the Z400 3D Printer to apply a higher saturation 
level to the outer skin and internal infrastructure, 
and a lower saturation level to the remaining 
internal areas.  The interior areas are printed at a 
consistent level, but the outer skin will be printed 
at a variable level depending on part geometry. 
The Software will recommend a saturation level, 
and if you wish to use that level, ensure that 
‘100%’ appears in the level box.  If you wish to use 
another level, you can type a value in the 
Saturation Value box. Please refer the the Powder 
Fact Sheet for recommended saturation values.  

   3. Select COM Port.  The third print parameter is the COM port setting for the serial cable 
connection to the printer.  The default is COM1; if you have connected the Z400  printer to another 
communications port, select it here and the Software will save that port as the default setting. 

3. Override Anisotropic Scaling.  Anisotropic scaling operates as a 
simple multiplier. Once you set new scaling factors, they will 
become the new default values.  The shrinkage or expansion 
you experience may differ from the norm because of humidity 
and temperature variations between operating environments.  
To more precisely calibrate the Z400  System to your 
environment, see section 7.4, Calibration for Anisotropic 
Scaling. 
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5.  Select ‘3D Print’ from the file menu or the 3D 
Print icon on the toolbar.  The first dialog box 
reminds you of the pre-print checklist.  Ensure 
that the Z400  System operator has prepared 
the three dimensional printer to print. 

 

 

 

Warning: Failure to ensure that the Z400 3D Printer is fully prepared for printing could result in poor 
print quality and/or a big mess.   

 

6. Select print range.  Select either 
entire build or the specific range of 
layers that you would like to print.  If 
you wish to only print a particular 
cross-sectional slice of your part, 
enter the range of layers that you 
wish to print.   

 

 

If you wish to use the delay timer feature, check the appropriate box.  You will then be asked to enter 
how many hours in the future you wish your build to begin. 

Warning:  After you set the anisotropic scaling feature and before you print, carefully check the 
build area.  If you have placed parts close together in the build box or have scaled parts to fill the 
build box, the changes made by anisotropic scaling may cause the parts to overlap and some 
additional manipulation may be necessary.  It is best to set anisotropic scaling before setting up the 
build. 
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7.  If the Warning Window pops up, 
recheck either the powder 
available in the feed piston or 
the build piston as instructed.  
After you correct the problem, 
choose ‘Remeasure.’   

If problem is corrected, choose 
‘Go Ahead.’ 

 

The Z400 System will commence printing your part.   

During printing, the ZPrint Software will display the progress of the print and will monitor the key 
operating characteristics of the Z400 Printer. 

 

 

 

For more information about the ZPrint Software, please refer to the ZPrint Software Manual. 
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5. POST PROCESSING OF PARTS 

5.1. REMOVING FINISHED PARTS 

After the build is complete, remove the finished parts from the build box as follows: 

1. Wait approximately ten to fifteen minutes to ensure that the uppermost layers of 
the starch based model have had a chance to dry. With plaster-based  models, 
the models will be easiest to remove from the powder bed if left in the bed for an 
hour after printing before removing the model from the build bed. Depending on 
wall thickness, plaster models may take up to four hours to achieve full strength.  

2. Take the machine offline by pressing the Online Button. 

3. Move the Gantry to the Feed (left) end of the deck by pressing the Spread 
Button. 

4. Lift clear  Top Cover. 

5. Vacuum up any powder spilled on the deck. 

6. Place a tray on the deck to the right of the Build 
Box. 

7. Take a moment to look at the computer screen 
and determine exactly where parts lie in the 
build box. 

8. Without raising the build piston, begin vacuuming powder out of the build box.  
Hold the end of the hose on a 20° to 30° degree angle over the powder so the 
hose inlet is 1/4” to 3/8” above the surface of the powder.  This generates 
enough of a draft to lift loose powder without 
shifting parts.  

9. Vacuum powder away from the buried parts, 
and clean powder out of the margins against 
the walls of the Build Box. 

10. To gain access to the sides of the parts, raise 
the Build Piston by holding down the Build Up 
button.   

 

 

Warning:  When performing any vacuuming operation, use the vacuum provided as part of the Z400 
System.  Vacuuming powder can generate static electricity, and use of a non-grounded vacuum will 
create static charges, which may affect the operation of the Z400  System, and be uncomfortable for 
the operator. 
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10. Vacuum up as much powder as possible using the various 
attachments provided. 

 

11. Lift parts out of the Build Box and place them on the tray.  
Large parts should be lifted from underneath.  Carry parts 
over to the Depowdering Station. 

12. Finish cleaning up loose powder from the Top Deck and 
Build Box.  The tidier the machine, the less often it will 
need maintenance. 

13. Close the clear Top Cover.  

14. Move Gantry to the Overflow (right) end of the deck by pressing the Spread Button.  

15. Open the clear Top Cover. 

16. Finish tidying up the Top Deck. 

17. The machine is now ready to set up for the next build. 

TIPS & TRICKS… 

If your Z400  System will not be used in the next 24 hours, go ahead 
and squirt some distilled water on the suction cup in the car wash. 

This will keep the jets on the Binder Cartridge from drying out. 
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5.2. DEPOWDERING PARTS 

1. Place parts inside of depowdering unit.   

2. Using the compressed air system included 
in the ZD4i Depowdering Station, remove 
any excess powder that remains in any 
concave surfaces. 

TIPS & TRICKS… 

The air pressure on your Depowdering Station is adjustable.  For 
bulky parts, turn the air pressure up.  For more delicate parts, turn the 
air pressure down. 
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5.3. DRYING THE PARTS 

Drying procedure will depend on the infiltration material you wish to use.  To infiltrate parts with wax, 
the parts must be hot and dry.  Preheat part at 165 degrees Fahrenheit in the ZW4 Automated Waxer 
or the drying oven, remembering that drying time and part wall thickness are directly related.  If the 
average wall thickness is ¼”, then the part should be in the drying oven for fifteen minutes.  If 
average wall thickness is ½” inch, the part should be in the drying oven for ½ hour.  Use the chart 
below as a guide. 

 Average Wall Thickness Drying Time 

 1/8 inch 8 minutes 

 1/4 inch 15 minutes 

 1/2 inch 30 minutes 

 1 inch or greater 60 minutes 

For parts with average wall thickness greater than one inch, drying time should not exceed one hour.  
Dramatically over drying a part will lead to undesirable shrinkage, while dramatic under drying will 
lead to part softening. 

For directions on how to use the ZW4 Automated Waxer or ZW3 Waxing Unit, please refer to the 
Waxer User Manual. 

5.4. INFILTRATING THE PARTS 

The parts can be infiltrated with a variety of materials, depending on the intended use for the parts.  
As an early stage design tool, it may not be necessary to infiltrate the parts at all.  If you wish to use 
the parts for focus groups or to send to vendors, you may wish to infiltrate with resin, a two-part 
epoxy or other material for greater strength.  For information on other possible infiltration materials 
call us at Z Corporation. 

For directions on how to use the ZW4 Automated Waxer or ZW3 Waxing Unit, please refer to the 
Waxer User Manual. 

5.4.1. TO INFILTRATE PARTS USING RESIN: 

1. Read and understand the Safety Information on the resin  bottle label. 

2. Dry the part as outlined in section 6.3. 

3. In a well-ventilated area, place the part on wax paper or on another non-stick surface. 

4. Apply a thin coat of resin  to the entire part by gently squeezing the bottle and letting the 
resin drip onto the part.   

5. Once the entire part is coated let it dry for 45 minutes to one hour.  To stop the part from 
sticking to the wax paper, pick it up and move it every ten minutes until dry. 

6. Once the part is dry it can be sanded to improve the surface finish (250 grit sandpaper 
works best).  This operation should be performed while wearing a dust mask. 
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7. To further improve the surface finish, the part can be waxed.  To wax a part infiltrated 
with resin the part must be heated at 165 degrees Fahrenheit for one to three minutes 
and then waxed as outlined in Section 6.4.1. 

NOTE: Please carefully read the Material Safety Data Sheet for infiltrants before use.
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6. ADVANCED USER FEATURES 

6.1. ORIENTATION FOR SPEED 

Parts oriented with their largest dimension along the y-axis (binder cartridge direction of travel), next 
longest along the x-axis (gantry direction of travel) and shortest dimension along the z-axis will print 
the fastest.   

Because speed is the most important feature for the majority of our customers, the Software will 
automatically position parts with the shortest dimension along the z-axis. 

6.2. ORIENTATION FOR STRENGTH 

In section 1.1.2, How it Works, we explain that part features that lie in the x-y plane will be stronger 
than those aligned along the z-axis.  If a part has a particularly delicate feature, especially one 
shaped like a thin rod, you might find aligning that feature in the x-y plane to be most successful.  

6.3. ORIENTATION TO PREVENT WARPING 

Very thin planar part features printed in starch-based powder may warp if they dry unevenly or are 
excessively heated (this problem will not occur with plaster-based powder ).  Thin, planar features 
aligned along the z-axis will dry more evenly than those with thin planar features that lie flat along the 
top of the build box.  Also, be careful when drying parts with thin planar features in the drying oven.  
We find that thoughtful positioning and limited drying time effectively control warping in starch-based 
powder. 
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6.4. CALIBRATION FOR ANISOTROPIC SCALING 

To calibrate your machine precisely to your environment, 
take the following steps: 

1. Select ‘3D Print Setup’ and reset all of your anisotropic 
scaling factors to ‘1’. 

2. Select ‘Open’ from the File menu and look in the 
‘Samples’ folder within the Z Corporation folder.  In the 
Samples folder you will see a file called ‘crosses.bld’.  
Open this file. 

3. Print this build without making any changes.  Post-
process the crosses in your usual way. 

 

4. The axes of the crosses are labeled according to their direction of print.  Using a caliper, 
measure each cross along each dimension as indicated and record each measurement in the 
chart below.  Follow the calculation indicated and determine your scaling factors. 

Dimension: True Scale Measurement: True Scale Divided by 
Measurement=         

New Scaling Factor 

x-axis 2”   

y-axis 2”   

z-axis 2”   

 

5. Select ‘3D Print Setup’ from the File menu.  Choosing the ‘Override Anisotropic Scaling’ Button 
and enter the new scaling factors.  These factors will become the new default settings. 

6.5. SATURATION SETTINGS FOR POWDER 

The saturation settings for plaster-based powder are constant for all parts.  The default 
saturation values suggested by the Software for starch-based powder are designed to successfully 
print a majority of parts.  Please refer to the Powder Fact Sheet for recommended saturation values. 
You may, from time to time, choose to override these saturation levels. 

In general, bulkier parts will print more successfully with a lower maximum setting and 
delicate parts will print better with a higher setting.  Below are some part examples with our 
recommended saturation settings.  In the layer thickness column there are a range of workable 
values, with a recommended values in bold. 
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Type of Part: Layer 
Thickness

: 

Saturation
Value 

Comments: 

 

Solid Block 

.008” 

.007” 

.006” 

 

1.15 

 

Make sure the part is fully dry before 
infiltrating with any material. 

 

Mix of mass and detail 

 

.007” 

.006” 

 

1.25 

 

Be sure to depowder the part within 30 
minutes of the completion of the build. 

 

Less mass and more detail 

.008” 

.007” 

.006” 

.005” 

 

1.35 

 

For wall thickness’ of 1/8 to 1/4 inch, let 
the part sit in the bed for 10 minutes 
before removal. 

 

Thin walls, little mass 

.008” 

.007” 

.006” 

.005” 

 

1.8 

 

For wall thickness’ of 1/16 of an inch, let 
the part sit in the powder bed for 15 
minutes prior to removal. 
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7. MAINTENANCE 

7.1. ROUTINE MAINTENANCE 

The Z400 System has  three regular maintenance steps: 

7.1.1. CHANGING THE BINDER CARTRIDGE  

Warning:  Do not touch or contaminate the gold contacts on either the binder cartridges or the 
carriage with your fingers.  Avoid spilling binder on the contacts.  If you do get binder or anything else 
on the gold contacts, clean them with a swab soaked in alcohol. 

If the print becomes faint or begins to “stripe out”, replace the binder cartridge as follows: 

1. The printer should be on line.  Start 
the ZPrint Software program.  From 
the ‘Service’ menu, select ‘Change 
Binder Cartridge’.  If you do not have 
this option, then you need to obtain a 
newer release of the ZPrint Software 
(v 6.0 or later).  This dialog box 
should appear: 

2. Fill the number from the new binder 
cartridge into the serial number box.  
This number will be used to create a 
file name for automatic data logging. 

3. Make sure the printer is online and 
the top cover is closed.  Press the 
‘Start’ dialog box button to begin the 
process.  The front panel lights will 
flash rapidly and the gantry and 
binder cartridge will move into 
position. 

 

 

What: When Using starch-
based powder:        

When Using plaster-
based powder: 

1.  Change Binder Cartridge As needed                      As needed 

2. Flush Binder Bi-Weekly Bi-Weekly 

3. Lubricate the Fast Axis 

4. Oil Snowplows 

Monthly     

Before Every Build              

Weekly 

Before Every Build 
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4. Wait for the Printer to finish moving 
and the front panel lights to change to 
slowly blinking.  This indicates that the 
power to the printer assembly has 
been turned off and that it is safe to 
remove the binder cartridge from the 
carriage. 

5. Remove the cap from the new 
cartridge.  The cartridges are filled 
with clear binder for storage.  Open 
the top cover of the printer and place 
the new cartridge on the top deck of 
the printer near the carriage. 

 

 

6. Lift the green lever and remove the 
old binder cartridge from the carriage. 

 

 

 

 

 

 

 

 

 

7. Clean contacts on both the binder 
cartridge and the carriage with the 
swab provided with your binder 
cartridge.  
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8. Unscrew the retaining ring from the 
top of the old binder cartridge, slide it 
up the tubes somewhat and remove 
the feed tube fitting. 

 

 

 

9. Without removing the fluid from the 
new binder cartridge, insert the 
printcap assemblye into the new 
binder cartridge assembly. Orient the 
fitting as shown; try to avoid tangling 
the feed and return tubes. Make sure 
the metal insert is all the way inside 
the clear tube, then slide the retaining 
ring down and gently screw it on.  
NOTE: Do not over tighten the 
retaining ring, otherwise it will be very 
hard to get off.  The seal is provided 
by the o-ring on the metal insert and 
the ring is only there to keep the 
internal pressure from forcing it out. 

 

 

10. Remove the orange cap and tape 
from the face of the binder cartridge. 

 

Retaining ring 

Feed tube fitting 
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11. Re-insert the binder cartridge into the 
carriage.  Lower the green lever to 
latch the cartridge in.  Wiggle the 
cartridge to make sure that it is well 
seated 

 

 

12.  Close the cover and press the ‘feed 
up’ button once. The printer will re-
zero, then it will fill and prime the 
binder cartridge automatically.  After 
this fill cycle, the machine will shut 
itself off and re-start.  Once the 
machine has come back on line, 
press the ‘done’ button on the 
Software dialog box. 

 

 

That should complete the binder cartridge change process.  Before starting a long build, it is worth 
verifying binder cartridge function with a few layers of a solid part.  In some cases, a binder cartridge 
will print unevenly at first, however printing heavily for a short time, then re-starting the printer will 
help a binder cartridge that has been in storage for some time to start up. 

Note:  If the air bubble continues to grow or does not disappear, there is a leak.  If this occurs, check 
the fitting connection.  If this does not fix the problem, install a new binder cartridge. 

TIPS & TRICKS: 

Keep your Z400 3D printer as clean as possible.  The cleaner it is, the better it will work. 

Before each build, or if the printer is going to be idle for some time, slide the carriage out and rinse out 
the car wash area with some distilled water using the supplied squeeze bottle. 

 

7.1.2. FLUSHING THE BINDER 

1. Binder should be flushed bi-weekly for one minute. This may be done by choosing the 
‘Service’ menu in the Software. 

2. Choose the ‘Binder Flush’ option. 

3. The ‘Online’ and ‘Error’ lights will begin blinking. 
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4. Press the ‘Feed Up’ button for one minute. The binder should begin flushing through the 
binder cartridge. 

5. When finished, press the ‘Online’ button.   

6. To begin printing, put the machine online by pressing the ‘Online’ button again. 

 

 

 

 

7.1.3. LUBRICATING THE FAST AXIS  

1. Turn power off. 

2. Remove print cartridge from the binder cartridgee holder by lifting green lever 
and removing print cartridge.  Do not remove printhead cap assembly from 
cartridge.   

3. Push green lever back down to the secure position. 

4. Note the small circle in the center of the gray plate in the binder cartridgebinder 
cartridge holder.  Insert head of grease tube into hole and apply one quick 
squeeze of  grease 

 

 

5. Move print assembly back and forth on gantry to evenly distribute grease.  You 
will be able to see the grease on the print assembly (fast axis) rail. 

6. Replace print cartridge in the binder cartridge holder and secure by depressing 
green lever. 

Note: If machine will not be in use for more than a month, replace binder gallon with a gallon 
of distilled water and flush the system for 5 minutes. Leave the distilled water in the machine. 
When ready to use the Z400 3D Printer, replace distilled water with Z Corp binder and flush 
system for 5 minutes. 
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7.1.4. OILING THE SNOWPLOWS 

Snowplows help keep away from the top deck and damaging the binder cartridge. There are two 
snowplows located between the roller on the gantry. These will need to be oiled before every build. 

 

7.1.5. LUBRICATING THE SLOW AXIS  

The Slow Axis of the Z400 Printer should be lubricated on an annual basis.  This level of 
maintenance is only to be performed by or under the guidance of an authorized Z Corporation 
Service Professional. 

 

For more information or assistance with maintenance of your Z400 System, please contact the Z 
Corporation Service Department at (781) 852-5050 or (877) 88-ZCORP or via email at 
service@zcorp.com.  
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7.1.6. CHANGING THE COLOR OF THE BINDER  

The ‘Flush Binder’ command will make it easier to change the color of binder in your system. 

 

1. The printer should be online and the cover closed.  From the ‘‘Service’ menu, 
select ‘Flush Binder’.  The printer will move the carriage to the flush position and 
the on line and error lights will flash.   

2. Remove the old bottle of binder and replace it with the new one.   

3. Press and hold the ‘Feed Up’ button on the front of the Z400 printer to pump the 
new binder through the system.  It will take about five minutes for the new color 
to come through (you may want to go longer than this if changing to a very light 
color from a dark one).  Releasing the ‘Feed Up’ button will stop pumping binder.   

4. Press the ‘Online’ button to exit the flush binder mode.   

5. Press ‘Online’ again to put the Z400  printer back on line. 

You may want to print a few layers of a thick part to verify that the old color is completely purged out.  
Also, with the printer off line, slide the carriage out and clean out the car wash area with your squeeze 
bottle of distilled water.  This will clean out any of the old color collected on the car wash, which may 
tend to get into the printed area. 
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7.2. TROUBLESHOOTING 

Here are a few troubleshooting tips from our service department.  The solutions outlined below can 
be performed by any user.  If you have any questions, or these steps do not resolve your problem, 
please call the Z Corporation Service Department at the number below. 

7.2.1. UNDERSTANDING AUDIBLE ERROR MESSAGES 

Certain error conditions will cause the Type III Z400 Printer to sound an audible alarm once per layer.  
A pattern of beeps is used; the error light will blink along with the beeps.  If an error condition 
persists, the error light will remain lit. 

General errors; may happen and be reported at any time: 

Online Error beep Name Description, notes, possible remedies 

Fast Fast On Cover 
open 

Online & Error light alternating. The cover was opened before or 
during a move.  Close the cover and the move will start.  Can also be 
while offline, and user pressed <Spread> key with the cover open. 

Slow On On Cow 
catcher 

The cow catcher interlock was set off.  Clear the error by tapping the 
cowcatchers on both sides of the gantry. Close the top cover and then 
push online.  

Print time errors; reported each time a new layer is spread: 

Three beeps Front door is open Front doors are open or 
ajar. 

Open the doors and re-close them tightly. 
Make sure nothing is keeping them open. 
Check for excess powder build up in the 
overflow area due to loss of vacuum. 

 

Beep codes for binder cartridge temperature sense errors: 

Online Error beep Name Description, notes, possible remedies 

Slow Fast Slow Critical – Too 
Low 

One burst every 5 seconds.  Printer will be frozen; pressing online key 
will cause it to shut down.  Binder cartridge is open circuit.  Either 
binder cartridge is failing, or carriage contacts are fouled.  Shut off 
printer, change cartridge;  clean contacts,  do head change after 
printer restarts. 

Slow 
(2x) 

Fast Slow 
(2x) 

Critical – Too 
High 

One burst every 5 seconds.  Printer will be frozen; pressing online key 
will cause it to shut down.  Binder cartridge is short circuited.  Either 
binder cartridge is failing, or carriage contacts are fouled.  Shut off 
printer, change cartridge;  clean contacts,  do head change after 
printer restarts. 

Slow 
(5x) 

Fast Slow 
(5x) 

Critical – 
multi-deprime 

One burst every 5 seconds. Printer will be frozen; pressing online key 
will cause it to shut down.  Print pass got a de-prime, and then got a 
second temperature error after re-priming. Cartridge is probably failing 
intermittently (common with ZB6). .  Shut off printer, clean contacts, 
change cartridge; do head change after printer restarts. 
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7.2.2. THE BINDER SOLUTION IS BEING APPLIED IN ERRATIC STRIPES 

If the binder appears to be applied in fragmented stripes, check the following:  

First check the nozzle on the binder cartridge--it may be clogged.  Rinse the squeegee clear 
of any debris. 

Second, ensure that the fitting on the binder cartridge is tightly attached.  If it is not, a bubble 
will appear in the binder feed tube. 

If this does not correct the problem, your binder cartridge may be worn out.  Replace the 
binder cartridge as outlined above in section 7.1.1, Replacing the Binder Cartridge.  A binder 
cartridge can be expected to last for several builds. 

7.2.3. THE PROGRAM FREEZES UP UPON STARTING  

Ensure that your monitor is set to 16-bit color and that your video card has at least 2MB of 
memory.  You can check your monitor settings by right clicking on your desktop on the main 
Windows window.  Choose “Properties”, click on “Settings” and choose the appropriate color 
depth. 

7.2.4. THE COMPUTER FREEZES AND THE Z400 PRINTER STOPS PRINTING 

Power management hardware and software may cause the computer driving the Z400  
Printer to suspend during a print.  If this occurs, you must restart the computer and disable 
these power management features.  You may then re-prepare the Z400 3D Printer and 
attempt the print. 

7.2.5. THE ZPRINT SOFTWARE FREEZES DURING USE 

Exit the Software by pressing Ctrl_Alt_Delete and choosing End Task from the Task 
Manager, then restart the Software.  

7.2.6. THIN PLANAR PARTS ARE WARPING  

In general, warping is caused by uneven drying of parts.  You can take steps to ensure that 
drying is occurring evenly by: 

1. Reorienting your part within the build box.  If a thin planar surface of a part lies flat along 
the top of the build box, the broad exposed area may dry unevenly and bow towards the 
top.  Reorient the part so that the thin planar surface lies perpendicular to the top of the 
build box. 

2. Ensure that you are not over-drying the part.  Reduce drying time to a minimum.  Refer to 
the guide in section 5.3, Drying the Parts to select a drying time. 

3. Decreasing the layer thickness without proportionally changing the minimum and 
maximum saturations will over saturate the part causing it to warp and may also cause 
individual layers to curl during printing.  

By adjusting print orientation and drying time, warping can be minimized. 
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7.2.7. POOLS OF BINDER SOLUTION ARE OBSERVED ON THE DECK 

While a small amount of binder spray is normal, if pools of binder solution form, the following 
actions should be taken: 

Check the Binder Cartridge to make sure the feed tube is firmly attached. 

Carefully clean the Gantry and Binder Cartridge and ensure that no caked powder is 
inhibiting normal operation.  If this has occurred, review normal operating procedures 
and keep the machine clean at all times. 

7.2.8. NOTHING HAPPENS WHEN YOU TRY TO PRINT  

A. Is the serial cord connected properly? 
 
Remove the cord and carefully reinstall ensuring that you tighten the screws only after 
making sure that it is tight in the socket.  Do NOT over tighten the screws. 

 
B. Is the power cord plugged in? 
 
Please make sure the power cord is securely plugged into the machine and the outlet. 
 
C. Are any of the lights on the control panel illuminated? 
 
If the error and power light come on but nothing happens after that, shut the machine off and 
turn it back on again. The machine should come online. But if it does not, please give us a 
call.  
 

If the power light is the only one on, please call Service.Reattempt printing.  If printing does 
not occur, please call our Service Department. 

7.2.9. YOUR PARTS ARE UNUSUALLY “CAKEY” 

A. Is the saturation too high? 

If your parts (especially bulky parts) are unusually difficult to depowder, too much moisture 
has moved from the part into the immediately surrounding powder.  There are two likely 
solutions.  The first is that you may have the saturation levels set too high for this type of part.  
Using a lower maximum setting will fix this problem.   

B. Was the model left in the bed too long? 

If the part is delicate and requires a higher maximum setting, it will be helpful to remove the 
part from the bed as soon as possible after the completion of the build.  Using the delay timer 
feature will allow you to cause the build to end at a convenient time. 

7.2.10. PARTS ARE UNUSUALLY WEAK OR CRUMBLY 

A. How many hours are on the binder cartridge? 
 
Print cartridges have an average life of 5 billion pixels.   
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B. When was the last time the machine was used? 
 
Not using the machine for over a week will dry out the binder cartridge.  Go ahead and 
change the print cartridge.  
 
 
C. Is the file known to be free of errors? 
 
If the file is not near perfect you will have problems printing the part.  Open the file in the 
Software and inspect it layer by layer to ensure there are no gaps and the part does not 
overlap other parts.   
 

 
D. Are the carriage contacts clean? 

 
Shut the machine off, remove the binder cartridge and clean the contacts of the head and 
carriage using a cotton swab and rubbing alcohol.  Reinstall the binder cartridge and turn the 
machine on. 

 
 

E. Is there enough binder in the feed bottle? 
 

When you start the build a reminder box will pop up asking you to check if there is enough 
binder in the feed bottle.  If you plan to start a large build make sure there is at least 2 inches 
of binder left in the bottle.  If the bottle is empty put another bottle in and perform the flush 
binder option under "Service" in the Software until all the air has been purged.  You may also 
use this option when changing the binder color. 
 
F. Are there layers missing from your model? 

If whole layers of the build are missing (contain no binder) there is most likely a bad reading 
from an important sensor.  Call Z Corp. Service for instructions. 

7.2.11. PRINTER LOOKS LIKE IT IS PRINTING, BUT IS LAYING DOWN NO BINDER 

One possible cause of a this symptom is if the binder cartridge is not properly seated in the 
carriage.  This can cause a bad connection with the temperature sensor and allow the head 
to overheat.   

Begin printing and watch carefully to see if the Z400  is printing normally.  Unfortunately, 
prolonged periods of attempting to print without binder flow will damage the head.  It is likely 
that you will be forced to replace the binder cartridge.  If you do, please ensure the the binder 
cartridge is firmly seated in the carriage. 

7.2.12. AFTER A BUILD THE DECK IS COVERED IN POWDER 

A. Is the vacuum on? 
 

The vacuum should be on. If not, you have vacuum motor that is not working properly. 
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B. Is the Printer vacuum bin full? 
 

If it is full, you may have forgot to change the overflow bin before you started the build.  
Before you print there will be a reminder window asking you if you checked to see if the 
overflow bin is empty. 

 
C. How do I properly clean the top of the machine? 
 
Follow the procedure in the Z Corp Z400 System User Manual.  When you are finished and if 
the machine does not respond or turn on correctly, contact Z Corporation Service 
Department.  
 
D. Is the vacuum filter clean? 

 One possible cause of this symptom is that the filter in the bag of the powder overflow box 
has become clogged, reducing the airflow through the overflow chute.  Remove the powder 
overflow bag and vacuum off the filter at the back of the overflow box.  Clean the machine 
and resume normal operations. 

7.2.13. ALARM IS RINGING AND MACHINE WON’T FUNCTION 

 

A. Did it happen during the startup procedure? 
 

When the machine is turned on, it checks the two safety switches (back switch, and top cover 
switch) and also makes sure there is a printer cartridge present.  If it's one long beep it's a 
safety switch problem. If the vacuum is not running, make sure the lower left corner of your 
back panel is tight.  If the problem persists call the service department. If the top cover is not 
lowered during start-up, the machine will also produce a long beep. 
 
If the online and error lights blink quickly along with a series of short beeps it is not sensing 
the print cartridge.  Turn the machine off, remove the printer cartridge and clean the head 
and carriage contacts with a swab and rubbing alcohol.  Reinstall the printer cartridge and 
turn the machine back on.  If the problem persists try changing the printer cartridge.   
 
If the problem persists, please give Service a call. 

 
B. Does it happen during printing? 
 
Make sure the vacuum bag is installed correctly and that the front doors are securely closed.  
If it gives one or two short beeps during each layer it is an indication that the printer cartridge 
is dying.  Take the machine off line and cancel the print job. Then change the printer 
cartridge. 

 
C. My problem is not described in section A or B.  
 
Call the Service Department. 
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8. APPENDIX 

8.1. USING ZP250 POWDER 
 
zp250 powder is the newest powder system formulated for Z Corporation 3D Printers.  Specifically 
formulated to have an open matrix to absorb infiltration resins, zp250 powder is an extremely 
versatile, composite-based powder used to fabricate models with plastic flexural properties which are 
ideal for snap fit applications.  It can be used as your sole powder to fulfill a number of application 
needs.  zp250 powder is best suited for monochrome parts. It is also recommended for parts that 
have a wall thickness that is greater than 0.06” (1.5 mm). 

8.1.1. MACHINE SETUP 

• Remove all of the powder currently in the Z400 (feed piston, build piston, overflow bin). 
• Remove all powder in the depowdering unit and install a new vacuum bag in the vacuum unit. 
• Check to see if the binder solution currently being used is compatible with zp250 powder.  If 

you are not currently using zb7 binder, replace the current binder with zb7 binder then flush 
and purge the fluids system in accordance with your respective printer’s user manual.  Zb7 
binder is the required binder system for zp250 powder. 

• Fill the feed piston with zp250 powder.  Z400 users may use the removable build plate (Z 
Corp. part number 06302) to aid in the removal of the 3D printed part after the build is 
completed.  Place the build plate onto the build piston and lower the build piston until the top 
surface of the removal build plate is slightly below the surface of the top deck of the 3D 
printer to make certain that the spread roller does not hit the build plate.   

 

8.1.2. SOFTWARE SETUP 

• ZPrint Software version 6.2 or higher should be used 
when printing with zp250 powder.  To check the 
version of ZPrint Software currently installed select 
“About Z Corporation Software” from the Help Menu.  If 
ZPrint version 6.2 or higher is not installed contact the Z Corporation Service Department for 
an upgrade at service@zcorp.com. 

• Due to the nature of the open powder matrix of zp250 powder, and its capacity to absorb Z-
Snap or Z-Max epoxy infiltrant, the use of a fixture generated in ZPrint Software is 
recommended for parts with a wall thickness less than 0.25” (6.35mm) on the Z400 Printer. 
For a complete explanation of how to use the “Make Fixture” function in ZPrint Software refer 
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to the ZPrint Software Manual.  Fixtures used as cradles for zp250 powder parts should be 
built with the following parameters: 

Clearance 0.125” – 0.25” (3.175 – 6.35 mm) 

Top Surface Thickness 0.1” – 0.25” (2.54 – 6.35 mm) 

Wall Thickness 0.1” – 0.25” (2.54 – 6.35 mm) 

Distance Between Wall by X 0.5” – 1.0” (12.7 – 25.4 mm) 

Distance Between Wall by Y 0.5” – 1.0” (12.7 – 25.4 mm) 

Accuracy Coefficient High enough to avoid collisions between the part 
and the fixture 

 

• To change the default values in the “Make Fixture” window, select “Preferences” from the 
ZPrint Edit Menu and select the “Fixtures” tab. Enter the new values, and click ‘OK’.  

  
 

• To create a fixture that completely cradles the entire part, raise the part in the z-axis at least 
0.5” (12.7 mm) from the bottom of the build plate in the ZPrint Software. If the part is not 
raised it will not be fully support by the fixture after depowdering.   
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• Go to the “3D Print Setup” window under the File Menu and select zp250 powder as the 
powder type. 

 

 

8.1.3. PART REMOVAL AND POST PROCESSING 

 

1. When printing parts that can be manually handled, allow the part and fixture to dry in the 
build bed for at least 2 hours before removing. If printing parts that cannot be manually 
handled, please refer to the Infiltration Addendum of this set of instructions. Parts built 
deeper than 2 inches (50.8 mm) into the build box may require longer drying time before 
handling.  If the removable build plate was used the part can be gross depowdered and 
removed prior to two hours and placed in an oven at 150°F (66°C) for at least 2 hours or 
longer depending on the mass/volume of the part.   
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If a fixture was used during the printing process it should be used as a cradle for the part 
during the infiltration and curing steps as well. 

 

2. Depowder the part and the fixture. 
 
3. Remove part from build plate and place on a clean surface. Then separate the part from 

the fixture. 

 

 

4. Apply a silicone mold release (such as IMS Paintable Neutral Oil Mold Release – 
www.imscompany.com or Hapco GREASE-IT FDG - www.hapcoweb.com) liberally onto 
the top surface of the fixture where the part will make contact with the fixture.  This is 
done to prevent the infiltrated part from adhering to the fixture during the infiltration 
process. 
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5. Gently apply Z-Snap or Z-Max epoxy to the bottom surface of the part and carefully     
place the part back onto the fixture. 

 
 

 
6. Apply Z-Snap or Z-Max epoxy to the rest of the part. Do not apply excess epoxy as 

pooling will occur.  Several thin coats are better than one thick coat.  Use a paper towel 
or tissue paper to remove excess epoxy that may have pooled on the surface of the part. 

 
6. Let the part sit for 30 minutes at room temperature to allow excess Z-Snap epoxy to drain or 

wick into the fixture.  Z-Max parts should sit at ambient for 1 hour prior to the oven cure. 
 
7. If using Z-Snap epoxy place the part with fixture into an oven for 30 minutes at 120°F (49°C). 

This step reduces the occurrence of unsightly bubbling or pooling of the resin. If using Z-Max, 
parts should be oven cured for an additional 2 hours at 160°F (71°C). 
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8. Parts infiltrated with Z-Snap should then be cured for an additional 2 hours in the oven at 
165°F (74°C).  

 
9. Let the part sit for 30 minutes at room temperature to cool before handling. 
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8.2. DESCRIPTION OF MENU OPTIONS 

File  

 New Open a new build file in which to insert files 

 Open   Open an existing build file in which files were already imported, rotated and scaled 

 Close Close the open build file 

 Save   Save the open build file 

 Save As Save the open build file under a new name 

 Import  Import an STL file into an open build file 

 3D Print Build the parts in the open build file 

 3D Print Setup Adjust the parameters for building the file 

 Print Time Estimator Estimate the time to build the open build file 

 Exit Exit the ZPrint Software 

 Upload New Firmware Upgrades firmware in Z400 Printer 

 Upload New Printer Configuration Upload Z400 printer calibration 

Edit  

 Copy Copy the selected model(s) 

 Delete Delete the selected model(s) 

 Normals Fix the normals which may have been incorrect in the original STL file 

Transform  

 Translate Move the selected model by an amount to be input by user  

 Rotate Rotate the selected model in any of the three planes 

 Scale Scale the selected model by inputting a percentage factor or inputting an exact x, y 
or z dimension 

 Justify Justify the selected model to the front, back, left, right or bottom of the build area 

View  

 One Layer Up View the cross section of the next layer up in the right hand window (or hit “a”) 

 One Layer Down View the cross section of the next layer down in the right hand window (or hit “z”) 

 Ten Layers Up View the cross section of the layer 10 layers up (or hit Shift-“a”) 

 Ten Layers Down View the cross section of the layer 10 layers down (or hit Shift-“z”) 

 Fast Rendering View a simplified rendering of the models in the build file; although not as good a 
rendering, this will render to the screen much faster, which is helpful if the file is very 
large 

 Calculate Part Volume and 
Surface Area 

This feature calculates the part volume and surface area 

 



Z400 User Manual Z Corporation 

8-9 

8.3. DESCRIPTION OF REAR I/O PANEL  

Power Input Diagnostic
Video Connector

Diagnostic
Keyboard Connector

Main Power Fuse Serial  Input
Connection  

 

Serial Port Connection:  This is an RS-232 serial port for data transfer to and from the Software.  
The Z400 System uses 115k baud and has the same pin out as a standard PC compatible computer.  
The connection to the Windows computer running the Software requires a 9 pin to 9 pin null modem 
cable (also known as a ‘laplink’ cable).  This cable is supplied with your Z400 System; if a 
replacement is required, order Z Corporation part #10267. 

Diagnostic Connections (Video and keyboard):  These connections are used while servicing your 
Z400 System.  Nothing should be connected to them in normal operation.  The diagnostic video 
connection is standard VGA output video.  The keyboard connection is PS/2 style compatible. 

115 Volt Z400 System: 

Power Inlet:  Connect, using the detachable power cord supplied with the system, to a standard 
wall outlet.  The Z400 System requires 115 Volts +/- 10%, 60Hz, 8 Amperes maximum.  
Replacement power cords are available from Z Corporation. 

Main Power Fuse:  Replace with type 3AG 8A/250V fast blow fuse only.  If this fuse should ever 
require replacement, it may indicate a serious problem with your Z400 System.  Please contact Z 
Corporation customer service.  The replacement fuse is available from Z Corporation, part 
#10277.  The fuse label on the rear of the machine is reproduced here for reference: 

ATTENTION:  Pour ne pas compromettre la protection contre les risques
d'incendie, remplacer par un fusible de meme type et de memes
caracteristiques nominales.

CAUTION:  For continued protection against risk of fire, replace only with
same type and rating of fuse.

FUSE:  3AG 8.0A/250V FB
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230 Volt Z400 System: 

Power Inlet:  Connect, using the detachable power cord supplied with the system, to a 
standard wall outlet.  The Z400 System requires 230 +/- 10% Volts AC 50/60Hz, 5 Amperes 
maximum.  Replacement power cords are available from Z Corporation, contact your 
customer service representative. 

Main Power Fuse:  Replace with type T6.3H/250V time delay, high break, 5x20mm fuse 
only.  If this fuse should ever require replacement, it may indicate a serious problem with your 
Z400 System.  Please contact Z Corporation customer service.  The replacement fuse is 
available from Z Corporation, part #10868.  The fuse label on the rear of the machine is 
reproduced here for reference: 

FUSE:  5x20mm T6.3H/250V

ATTENTION:  Pour ne pas compromettre la protection contre les
risques d'incendie, remplacer par un fusible de même type et de
mêmes caractéristiques nominales.

CAUTION:  For continued protection against risk of fire, replace
only with same type and rating of fuse.
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8.4. SYMBOLS USED 

The following symbols are used on the Z400 System: 

 

This is the international symbol for ‘standby power’.  It is used on the Z400 
System power switch.  The Z400 System is partially powered as soon as you plug 
it in.  The power switch is momentary contact and toggles the machine from idle 
mode to full power on mode. 

 This is the international symbol for ‘fuse’.  It is used to label the fuse rating for the 
main input power fuse on the rear panel of the Z400 System. 

 

This is the international symbol for ‘warning’ or ‘caution’.  It indicates the need to 
consult your manual for further information.  This symbol is in two places on the 
Z400 System.   

1. It is used on the rear, lower left to call your attention to the fact that only 
authorized personnel should open the Z400 System rear cover.  None of the 
normal operation and maintenance procedures described in this manual 
require you to remove this cover. 

2. It is used on the front cover next to the handle to call your attention to the fact 
that you should be careful not to drop the cover when closing it.  Due to the 
weight of the cover and the force of the air springs, it is possible to pinch or 
strain a finger or hand if it were to get caught between the bottom of the cover 
and the front slow axis rail. 
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8.5. SYSTEM SPECIFICATIONS 

Z400 System dimensions: 29” x 36” x 42” high (74cm x 92cm x 107cm high) 

Z400 System weight:   115 Volt system: 300 lb (136kg) 
230 Volt system: 330 lb (150kg) 

Power Requirements and operating conditions at Site of Installation: 

Power requirements for 115V Systems: 

• 115V ±10%, 50/60Hz, 8 Amps peak (<3A typical while idling or printing) for the for the 
Z400 TM System 

• 115V ±10%, 60Hz, 15 Amps for waxing unit on separate circuit 

• 115V ±10%, 60Hz, 14 Amps for depowderer and vacuum on separate circuit 

Power requirements for 230V Systems: 

• 230V AC ±10%, 50/60Hz, 5 Amps peak (1.5A typical while idling or printing) for Z400 
System 

• Additional power for the waxing unit and depowdering equipment; the exact requirements 
will vary with the options chosen, but will generally be less 230V AC ±10%, 50/60Hz, 8 
Amps each for the waxer and depowderer. 

Operating conditions: 68 to 85ºF, 20 to 60% Relative Humidity, non-condensing. 

Lithium Battery: Internal to the Z400 3D Printer is a lithium coin cell type battery.  This may be 
any one of the following: Type: CR2032, either Maxell, Panasonic, Renata, Sanyo or Sony. 
PLEASE NOTE: This battery is not in a user accessible area and is not user replaceable.  
The expected lifetime of the battery is in excess of five years.  Replacement will be handled 
by your Z Corporation customer service representative. 

FCC Notice:  Note: this equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to part 15 of the FCC rules.  These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment.  This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interferance to radio communications.  Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required 
to correct the interference at his own expense. 

CENELEC Class A warning: Note: this equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to EN 55022.  Class A devices are for office and 
light industrial environments, and are not generally suitable for home use. 

Warning: This is a Class A product.  In a domestic environment this product may cause radio 
interference in which case the user may be required to take adequate measures. 



Z400 User Manual Z Corporation 

8-13 

8.6. MATERIAL STORAGE PRECAUTIONS 

Carefully read the Material Safety Data Sheets (MSDS) before using any Z Corporation materials. 
These documents can be found on the User Group Website at www.zcorp-users.com.  

 

Material Storage Usage 

Powder Store powder on pallets in a cool, dry, 
ventilated area away from sources of heat, 
moisture, and incompatible materials.  Keep 
containers tightly closed. 

Use of powder in 
environments with more 
than 30% relative humidity 
will affect powder 
performance. 

Binder Store in cool, dry place, away from sun.  
Keep tightly capped. 

Binder is NOT recylable. 

Binder 
Cartridge 

Store in cool, dry place, away from sun.  
Keep tightly capped. 

 

Infiltrants Store in cool, dry place, away from sun.  
Keep tightly capped. 

For more information, visit 
the User Group Website at 
www.zcorp-users.com.  
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